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1  Make a Rough Cut

Before we get started on editing video clips, we have to understand 
how Premiere is laid out and how it keeps track of your footage, 
both within and outside of the software. Once we’re oriented, 
we’ll explore how to create a timeline, drag in only the parts of our 

footage that we like, and arrange clips to our liking.
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Project Organization

For a “real” editing project, the first step is to bring footage off the camera into a folder. Most 
cameras shoot onto a card that mounts on your hard drive like any other folder. One then 
copies the files from the camera card to, say, a fast external hard drive. For our purposes, we’ll 
emulate this idea somewhat.

Copy the Files from CameraCard to ProjectStructure
First, make sure you’ve downloaded the Course Files (see Introduction), and place them 
somewhere dependable—either somewhere on your internal hard drive, or on a fast external 
hard drive (USB 3, USB C, or Thunderbolt connections are often indicators of good speed). 
Premiere will continuously be reading these files, so a slow hard drive will impede your flow.

	L Open up the folder for Lesson 1. 

You’ll see two folders: one called CameraCard and another called ProjectStructure. The 
CameraCard folder is meant to emulate a card from a camera being plugged into your com-
puter. Different camera cards are organized differently, but somewhere on that card lives 
your footage.

ProjectStructure contains a series of folders. It’s a good idea to start with a folder structure 
like this that is copied every time you start a new project. That way, every project you do will 
have a consistent layout on your operating system.

In my default file structure, note that I’ve numbered each folder 
so that they appear in Finder/Explorer in the general order 
in which I work. Documents can be scripts, invoices, notes, 
etc., which you may consider expanding into subfolders. 

Video is where you’ll place your footage from the 
camera, or any external video sources. 

Audio will likely contain music, sound effects, voiceover, 
or audio files from an external audio recorder—and 
you may consider subfolders for these, as well. 

The project folder is where you’ll keep your Premiere 
project, as well as After Effects and Audition projects, 
if applicable. Renders is where you may put your After 
Effects exports, which might not be necessary. 

I recommend discrete folders for Review and Deliverables—it’s 
unlikely that your first draft will be your final cut. So, place your 
iterative exports in Review, and save your absolute last export 
for the Deliverables folder so you know where to find it later.

So, let’s pretend we’re doing this for real.

	L Change the name of ProjectStructure to Lesson1RoughCut.
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	L Then, just as we’d drag footage from our camera card into our folder structure, let’s drag 
the contents of CameraCard into the 02_Video folder.

So before we launch Premiere, our folder structure should look like this:

 
What’s up with not having spaces in file names? Once in a blue moon, a problem can arise as 
a result of a file name having a space. It’s fairly uncommon, but many editors play it safe and 
use underscores or TitleCaseWithoutSpaces in naming their files and folders.

So Why Do All This?
In some video editing packages, an import is an import—you add a 5 gigabyte file to your 
project, and your project file increases by 5 gigabytes. This is not the case with Premiere. 
Instead of truly importing a file, Premiere makes a reference to where the file lives on your 
computer. This allows editors to keep their project files small, which is easier for sharing and 
backup. Because of this feature, it’s crucial that your video assets live in a dependable, con-
sistent spot in your computer, and ideally stay there for the duration of your project. For our 
purposes, we will not move, rename, or reorganize anything within our project folder once 
it’s imported.

If a file is moved or renamed, you must then relink it within Premiere (see Compendium 
chapter 1, “Offline Media”).
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Getting Started in the Project Panel

	L Open up Premiere by finding it in your Applications 
folder, or through the Creative Cloud app.

Creating a New Project
The first thing we’ll see when launching Premiere is the 
Home Screen. 

	L Select New Project…

A project is where we’ll import and organize our assets and 
create our edits.

	L Let’s give our project a name: Lesson1RoughCut.
	L And, let’s save it in the 05_Project folder within the 

file tree we just created. Select that folder with the 
Browse… button.

Our file paths will differ, but 
yours should ultimately point 
to your 05_Project folder.

	L Click OK to create the project file.

7



Getting Started in the Project Panel� Switching Workspaces
T

h
e 

C
o

u
rs

e

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43

14 28 42 56 70 84 98 112 126 140 154 168 182 196 210 224 238 252 266 280 294 308 322 336 350 364 378 392 406 420 434 448 462 476 490 504 518 532 546 560 574 588 602

Switching Workspaces
Premiere’s interface is made up of a layout of panels. Because there are many panels to choose 
from, not all of which are helpful in every scenario, Premiere has a variety of panel layout pre-
sets, called Workspaces. The software defaults to the Learn Workspace, which displays the 
Learn panel. We don’t need that, so let’s switch to the Editing Workspace by clicking on Editing 
at the top of the screen, or selecting Window > Workspaces > Editing.

To learn how to customize a workspace to your liking and create your own presets, check out 
the “Workspaces” section in Compendium chapter 1.

The Project Panel
Our lesson starts in the Project panel, which is 
where we’ll import and organize our assets, store 
our sequences, and view lots and lots of data on our 
items. In the Editing Workspace, it sits in the bot-
tom-left corner of the screen.

This is a little small. We can resize the panel by 
clicking and dragging on the panel’s edges, or hov-
ering the cursor over the panel and pressing ` to 
make the panel full screen. Press ` again to return 
to normal. If you mess up your Workspace, you can 
reset it to the default in Window > Workspaces > 
Reset to Saved Layout.

Importing Footage
Let’s start by adding the four shots from the 02_
Video folder into the Project panel. There are a 
number of ways to do this:

	■ Drag and drop from Finder/Explorer into 
the Project panel.

	■ Go to File > Import.
	■ Double-click on an empty area inside the 

Project panel. 
	■ Use the Media Browser panel, which 

unlocks ingest options. See “Media 
Browser” (page 137).

Once we import the four videos, the Project panel 
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will have four nice thumbnails of four nice video clips. Change the size of the thumbnails 
with the size slider . Hover the cursor over the video thumbnails to get a quick 
preview of the video content.

Organizing the Project Panel
While our footage is linked to its location in Finder/
Explorer, we can do our own organization within 
Premiere and freely move things around. I find this 
much easier to do by leaving the Project panel’s 
Thumbnail view and switching to List view.

We can create folders within the Project panel 
that help us organize our stuff. Premiere calls these 
folders Bins.

	L Create a bin with File > New > Bin, or ⌘-B/Ctrl-B.
	L Let’s name the bin “Video.”
	L Then, hold down shift, and select the first and last 

video clip in the Project panel (to select all four 
of them), then drag them into the “Video” bin.

Viewing Metadata
Metadata is information about your video files. The Project panel displays a lot of it—just 
scroll to the right within the panel to see things like clip duration, resolution, and frame rate.
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The Source Monitor

The Source Monitor is where we’ll preview our footage and trim the unwanted bits of our video 
to prepare it for adding it into the timeline.

	L To bring a clip into the Source Monitor, double-click on it in the Project panel. Let’s start 
with 01CameraPlace.

Current timecode 
of the playhead

Zoom Factor

Timeline of our clip. At this view, the 
big ticks represent 30 seconds, but that 
scale will change as you zoom in. Click 
in this timeline to jump to a time.

The playhead cursor, 
marking our current 
time. Click and drag 
to scrub through 
your footage.

Timeline scrollbar

Select just the video (for 
dragging to a sequence)

Select just the audio (for 
dragging to a sequence)

Add a marker at the 
current time, or press M

Set the In/Out point 
at the current time, 

or press I and O

Jump to your In 
point, or press shift-I

Jump to your Out 
point, or press shift-O

Step back one frame, 
or press left arrow

Step forward one frame, 
or press right arrow

Play, or 
press 

spacebar Insert clip into your 
timeline, or press ,

Overwrite clip into 
timeline, or press .

Take a screenshot of your current frame and 
export it to the desktop, or press shift-E

Playback Resolution

Source Monitor settings

Clip duration

Button 
Editor

In and Out points

10
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Previewing Footage
There are a number of functions that allow you to play footage from the Source Monitor, but 
under the assumption that the Source Monitor is active. Note the blue highlight around the 
Source Monitor—this means that it’s the active panel, and our hotkeys will control this panel 
only. To activate a panel, simply click on it.

Press the spacebar to play your video. Press it again to stop. That was easy.
If you’re going through hours and hours of footage, watching everything play in real time 

is inefficient. You can (and should) fast forward and rewind to greatly speed up your process.
I like to visualize a throttle on a ship. 
Press L to shift your throttle forward slightly, and 

play your video at regular speed. Press it again to 
push your throttle further, playing at double speed. 
Pressing for a total of six times will play your video 
back at sextuple speed. Pressing J will pull back 
on your throttle, easing up on the speed. If you’re 
at resting position, pressing J pulls the lever back-
wards, putting your video in reverse. The idea 
above is the same here—pressing J multiple times 
will have you zipping backwards. You can press K to 
stop playback. Unlike the spacebar, K does not start 
playback. Shift-J and shift-L play your footage either in reverse or forward, but at half speed.

Getting comfortable with J, K, and L is a great way to speed up your process (no pun in-
tended). Furthermore, they’re all next to each other on the keyboard, so you can relax your 
hand and tear through your footage.

Press the left and right arrows to step through your footage one frame at a time. Press 
shift-left and shift–right arrows to jump five frames at a time.

Press the home key to jump to the beginning of your footage, and the end key to go to the 
end. Laptop keyboards can’t access these keys as easily—one of the reasons having a numpad 
can be helpful.

You’ve probably noticed the blue playhead moving around in the clip’s timeline. This is a 
great way to see how far you are in your clip. You can click and drag the playhead through the 
timeline, or click directly on a spot in the timeline to jump to that time. 

Some Notable Features
The Source Monitor has quite a few options, which are detailed in chapter 2 of the Compen-
dium. Here are some things to pay special attention to:

4x4x
3x

3x 2x

2x 1x

1x

ST
O

P

6x6x

5x5x

L

K

AheadAstern

J
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Timecode
Timecode is measured in Hours : Minutes : Seconds : Frames. The timecode on the lower 
left of the Source Monitor displays the timecode of the current playhead, and the one on the 
right shows the duration of the clip. This clip is shot at 24 frames per second, so the frames 
of the timecode will go from 0 to 23, before jumping back to 0 at the next second.

Zoom Factor
Increase the size of your video within the panel. Fit will fit your screen into the size of your 
panel. The 100% view is a good way to see the clip at its native resolution; go above that if you 
wish to look at your image in more detail. Don’t forget that pressing the ` key while hovering 
your cursor over the Source Monitor will make it full screen.

Playback Resolution
In order to make Premiere run more smoothly and use less of your computer’s resources, 
you can (and should) lower the resolution of your video upon pressing Play. Full will play 
your video at highest quality, 1/2 will skip every other pixel, and so on. The lower the resolu-
tion, the less taxing it is on your machine. Different resolution options are available depend-
ing on the resolution of your media. Keep in mind that this is just for playback—exported 
files will be full quality.

Timeline Scrollbar
Drag the handles on either end of the scrollbar to zoom in on the timeline, or press = to zoom 
in, and - to zoom out. You can also scroll by holding shift while moving your scroll wheel.

In and Out points
Now that we know the features of the Source Monitor, let’s start editing. I don’t want to use 
this entire clip—there’s extra time on the beginning and end of it that I don’t want in my edit. 
We’re going to designate In and Out points, which will tell Premiere that we’re only interested 
in part of this clip.

	L Use the playback controls (spacebar, J, K, L, home, and end) to find the beginning of the 
clip you’d like to use. 

There are a few frames from before the camera was set down that I’d like to chop out, so I’m 
going to set my playhead to 00:00:00:11.

	L Once you’re at the beginning of a section you’d like to use, press I or the  button to mark 
your In point.

This is where you’d like your clip to start.

	L Play until the end of the clip you’d like to use, and press O or the  button to mark your 
Out point. I’m setting mine to 00:00:02:21.
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Note that I consider setting In and Out points in the Source Monitor to be painting in broad 
strokes—I expect these to be changed later, and I don’t spend significant time tweaking them 
to be on the perfect frame.

Previewing In and Out Points
Press shift-I and shift-O to jump your cursor to your In and Out points. On a Mac, press op-
tion-K to play from your In point to your Out point. On a PC, this hotkey is Ctrl-shift-spacebar.

Editing In and Out Points
While I’m happy with these In and Out points, there are some options for modifying them 
after they’ve been created. You can simply press I and O again to create new ones. You can 
also click and drag on the blue In and Out point handles to shift your points around. And you 
can slide both your In and Out points simultaneously by clicking and dragging on the center 
of the gray bar.

You can clear your In point by pressing option-I/Alt-I, and clear your Out point by pressing 
option-O/Alt-O. You can also right-click on the gray bar indicating your In and Out points 
and select Clear In and Out. Feel free to fiddle with your points, but let’s return to the In point 
at 00:00:00:11 and Out point at 00:00:02:21 before proceeding.
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Creating a Sequence

All of our edits take place in a sequence, which is another way of saying timeline. The se-
quence to Premiere is the composition to After Effects, the canvas to Photoshop, and the 
artboard to Illustrator.

To get started, we need to reveal the New Item button , which may be hidden. In my case, 
I need to expand my Project panel to the right in order to reveal it.

We’ve also revealed a 
button to create a new bin.

Creating a Sequence based off the Source Monitor

	L Click and drag the image within the Source Monitor onto the New Item button.
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What Just Happened?
First off, we’ve created a sequence. It lives in the Project panel.

If an item in the Video bin was selected 
upon creation of the sequence, the 
sequence will be placed inside the bin. 
Otherwise, it’ll be placed outside.

Note a couple of things: The sequence has the same name as the clip we’ve created it from. It 
also might be in the same bin in the Project panel. 
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We’ll want to change both of these issues.

	L Create a new bin.
	L Name it “Sequences.”
	L Drag the 01CameraPlace sequence into the bin.
	L Rename the sequence “RoughCut” by clicking on the text that reads 01CameraPlace. 

Your end result should look like this:

Ensure that it’s the sequence 
and not the footage that’s been 
renamed and moved. Sequences 
are denoted with this symbol:

Let’s also scroll to the right within the Project panel until we see two important columns: 
Frame Rate and Video Info. Frame rate shows how many still images, or frames, make up each 
second of our video. Video Info shows the width and height of our footage and sequence, in 
pixels. 1920 x 1080 is the standard for HD.

The sequence we’ve just created will perfectly match our clip in these regards. Sequences 
can be any dimensions and a multitude of frame rates, but by creating one with the drag-and-
drop method we just used, we automatically configure our sequence to match our footage.

Now, onto the exciting stuff: we now have a clip in a timeline!
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The Timeline

The timeline is a visual representation of our sequence, and it’s where we will compose our 
edits. Let’s look at some features of the timeline and how we can comfortably use and nav-
igate through it. In the following pages, I may change some viewing preferences using the 
options below, so our screens may begin to differ.

Navigating the Timeline
Many of the timeline controls are very similar to the Source Monitor controls. For instance, 
we can zoom out with - and in with =. We can hold down shift and scroll with our mouse to 
move left and right within the timeline.

The scrollbar at the bottom of the timeline is another great navigation tool.

Slide an end handle 
inward to zoom 

in, or outward 
to zoom out Click and drag on the scrollbar to scroll left and right

Press \ to frame all your clips in a single view. Press \ again to undo.
Just as with the Source Monitor, the spacebar will toggle play and pause, and our JKL shut-

tle controls work as well. The home key takes you to the beginning of your timeline, and end 
takes you to the end. The left and right arrow keys advance by a single frame, and shift-left 
and shift-right arrow keys advance five frames.

If you hold down shift while dragging your timeline cursor, you’ll snap to an edit.
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Changing Your Clip Size
Enlarging your clips allows you to see thumbnail previews of your shots, making them easier 
to identify. There are two ways to do this:

	■ To enlarge your video clips, press ⌘-=/Ctrl-=. To shrink them, press 
⌘--/Ctrl--.

	■ To enlarge your audio clips, press option-=/Alt-=. To shrink them, press 
option--/Alt--.

	■ For both video and audio, you can click and drag your tracks on the left size of the 
Timeline panel to resize.
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The Program Monitor� Calibrating Playback
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The Program Monitor

By now, you’ve probably noticed that the Program Monitor, in the top-right area of the inter-
face, displays your timeline. Otherwise, it functions almost identically to the Source Monitor. 
Its playhead is linked to the one in the timeline—controlling one controls the other. With the 
Program Monitor active, the same playback controls used in the timeline work here.

Calibrating Playback
Remember Playback Resolution in the Source Monitor? Adjusting that is far more beneficial 
in the Program Monitor, especially when you start adding more and more to your timeline. If 
playback isn’t smooth, bring your Playback Resolution down to 1/4. If that’s still not cutting 
it, consider making proxies, as described in chapter 1 of the Compendium (and consider up-
grading your hardware!).

19



Adding More Clips to the Timeline� Drag and Drop
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Adding More Clips to the Timeline

Selecting In and Out points and adding clips to the timeline is the bread and butter of creating 
a rough cut. Let’s go over a handful of ways to add clips to a preexisting timeline.

Drag and Drop

	L Double-click on 02PremiereLaunch.mov from the Project panel to open it in the Source 
Monitor.
	L Let’s set an In point at 0:00:01:05 and an Out point at 00:00:03:10.
	L Just like we dragged the image from the Source Monitor onto the New Item button, let’s 

now drag the image into the timeline, just after our first clip.

There’s a fair amount to unpack in this figure, which was cap-
tured mid-drag, pre-drop. For one, my goal was to place my 
second clip just after my first. I can tell the two are adjoining 
because of the triangles that appear on the clip just before I 
release my mouse.

Also, note the Program Monitor displaying the last frame of 
the first clip.

Did you goof? This may be a good time to introduce you to 
my dear friend, Undo. Call upon her lifesaving abilities with ⌘-Z/Ctrl-Z—unless you’re like 
BoJack Horseman’s Kelsey Jannings, who once said, “I don’t make mistakes, BoJack. I do the 
crossword in Sharpie and I never learned the command for undo.”
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Adding More Clips to the Timeline� Drag and Drop
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The Overwrite Function
Our plan was to place our second clip after our first, but we didn’t have to do that. Had we 
placed clip 2 atop clip 1, we would have called upon Premiere’s Overwrite function, which 
truncates clip 1. Consider this example from the Compendium, in which the second clip 
overwrites the first:

The takeaway is this: When we drag and drop from the Source Monitor, we’re calling upon the 
Overwrite function, which can truncate other clips.

The Insert Function
What if I wanted to squeeze a clip between two clips, without any truncating? I could call 
upon the Insert function, which is basically the way my dog makes room for herself on my 
couch: by pushing away my wife to make room.

	L First, let’s set In and Out points on 04EditorLook.mov. Bring it into the Source Monitor 
with a double-click, and set your In to 00:00:08:00 and Out to 00:00:09:13.
	L Then, drag the image from the Source Monitor to the intersection of the two clips in the 
timeline, this time while holding down ⌘/Ctrl.

I call this the spiky wall of death, which means an Insert function is about to be performed.

Upon release, we should observe that 04EditorLook has pushed aside 02PremiereLaunch, and 
successfully inserted itself between the two clips. All clips have retained their original length.
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Adding More Clips to the Timeline� Drag and Drop
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The Replace Function
Let’s say I like the timing and placement of 02PremiereLaunch, but I wish it were showing 
03PremiereLaunch instead. Instead of starting from scratch, I can call upon the Replace  
function.

	L Fire up 03PremiereLaunch in the Source Monitor and set an In point at 00:00:00:20.

We actually don’t need an Out point, as the clip’s duration will be derived from the shot we’re 
replacing.

	L Drag 03PremiereLaunch from the Source Monitor over 02PremiereLaunch in the timeline, 
this time holding opt/Alt.

We’re now seeing 03PremiereLaunch where 02PremiereLaunch once was, with an In point 
chosen by us and a duration chosen by the length of the previous clip.

The Overlay Function
I can’t decide if I prefer 02PremiereLaunch or 03PremiereLaunch, so I’m going to keep them 
both in the timeline so I can easily toggle between the two.

	L Open 02PremiereLaunch in the Source Monitor, and drag it to the layer above 
03PremiereLaunch.

We’ve just added 02PremiereLaunch to V2, which is a video layer above our main video layer, 
V1. In this instance, because 02PremiereLaunch fills the screen, we’ll see that instead of 
03PremiereLaunch.
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Adding More Clips to the Timeline� Disable Clip
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Preview the Timeline
If the playhead isn’t already at the beginning 
of your timeline, move it there by clicking on 
the time ruler, or press home. 

Then, press the spacebar to watch your 
edit. The Program Monitor displays which-
ever clip the playhead is on. You may observe 
that these clips have quiet audio, although 
there’s nothing special happening.

Toggle Track Output
Let’s turn off V2, which contains 02PremiereLaunch, so we can see the layer below it, which 
contains 03PremiereLaunch.

	L Click the eyeball next to V2 to turn the layer off.

Play your edit again, and notice we’re not seeing the content 
within V2. This is a more elegant solution than deleting the 
clip—which, by the way, we’d accomplish by selecting it and 
pressing delete/Backspace.

	L Turn the track back on by clicking the eyeball again.

Disable Clip
As you add more clips to your layers, toggling the track output of an entire layer might not 
be what you want. Instead, you can also disable an individual clip, which prevents you from 
seeing it.

	L Either right-click 02PremiereLaunch and deselect Enable, or select the clip and press 
⌘-shift-E/Ctrl-Shift-E.

Disabled clips are darker

We’ve achieved a similar effect to toggling track output, but with a little more precision. 
Re-enable the clip by right-clicking 02PremiereLaunch and selecting Enable, or selecting the 
clip and pressing ⌘-shift-E/Ctrl-Shift-E once again.

Click (and drag) in 
the time ruler to 
move the playhead
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Basic Trimming and Rearranging� Trimming a Clip
T

h
e 

C
o

u
rs

e

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43

14 28 42 56 70 84 98 112 126 140 154 168 182 196 210 224 238 252 266 280 294 308 322 336 350 364 378 392 406 420 434 448 462 476 490 504 518 532 546 560 574 588 602

Basic Trimming and Rearranging

Premiere defaults to the Selection tool, which can do quite a bit. It’s our go-to for select-
ing clips, making basic trims, and moving clips around. It should already be selected, unless 
you’ve accidentally hit a keystroke. Note the selection of the Selection tool  in the Toolbar, 
or activate it with the hotkey V.

Trimming a Clip

	L Hover your cursor over the end of 02PremiereLaunch so it automatically changes into a 
red arrow.

	L Let’s drag this to the left to shorten 02PremiereLaunch.

Note the UI that pops up as you’re doing this. The first number tells you how much you’re ad-
justing the clip length, and the second tells you the new duration. Let’s make this clip shorter 
by -00:00:00:15, so its new duration is 00:00:01:15.

Playing it back, note that we’ll see 02PremiereLaunch, which then switches to 03Premiere-
Launch. However, the latter is a little short. Let’s slide that so it comes in later.

Moving a Clip

	L Simply select 03PremiereLaunch and slide it to the right.
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Basic Trimming and Rearranging� Selecting Multiple Clips
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You’ll see a similar UI popup as before, telling you the amount the clip is being moved.

	L Let’s move it to the right 15 frames.

Looking good, but I’d like 03PremiereLaunch to run a hair longer. Let’s extend it.

Extending a Clip
Nearly identical to trimming, extend a clip by grabbing its end and moving it to the right. 

	L Let’s extend 03PremiereLaunch by 14 frames.

Note: You can’t extend a clip into another clip, at least not with this tool. For example, I can’t 
make 01CameraPlace longer without first moving aside 04EditorLook. We’ll get to a solution 
for this in the next chapter.

Selecting Multiple Clips
I’ve decided I want to see the two PremiereLaunch shots between the other two clips. How 
do we do that? Well, we could certainly move 04EditorLook after the PremiereLaunches, but 
that will leave us with a big hole in the timeline. Yes, we can then click, drag, close it, yada 
yada, but let’s look at a more elegant solution.

	L First, we’ll need to select both PremiereLaunch clips.

You can probably guess that holding down shift while clicking both will do the trick, and 
you’re right. Or, you can click in an empty area in the timeline and draw a box around both 
clips, much like you can do on your desktop to select multiple folders.
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Basic Trimming and Rearranging� Move with Insert
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Start in a spot without any clips...

...and drag down until you select what you need.

Move with Insert
We’re going to move these clips before 04EditorLook while performing the Insert function. 
Think of the analogy of my dog pushing aside my wife—we’re going to push aside 04Editor-
Look to make room for these clips.

	L We will achieve this in the same way we performed the Insert function last time—by hold-
ing down ⌘/Ctrl while we move.

Holding down ⌘/Ctrl brings back our spiky wall of death, letting us 
insert clips before other clips as we drag them around.

And voila, we’ve placed our two clips before 04EditorLook.
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Basic Trimming and Rearranging� Move with Overwrite
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Move with Overwrite
Moving with Overwrite is the default function. So, if I’m feeling 03PremiereLaunch goes on 
a little too long and I want to cut to 04EditorLook sooner, I can simply drag said clip to the 
left—no hotkeys. It’ll perform an overwrite.

	L Let’s drag 04EditorLook 9 frames earlier.

Your end result should look like this:

Don’t stress too much if your timeline doesn’t align perfectly with mine. What’s important is 
that you understand these main concepts before moving on.
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